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Welcome to the latest issue of my Final Cut Pro newsletter!

The goal of this newsletter is to provide information helpful to the 
professional user of Final Cut Pro. This newsletter publishes around the 
middle of each month. Past issues are not archived, however, key articles 
are posted to my website for your reference. Unless otherwise noted, all 
references are to Final Cut Pro HD, and may not work under other versions.

Also, please invite your friends to visit my web site -- www.larryjordan.biz. 
We are working to make it a great Final Cut resource!
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Report from Uganda

I think this story is a great place to start. Sometimes, we get so caught up in the 
details of running our editing systems, we lose sight of a bigger picture.

Last October, Matt Warren, of Radar Multimedia, called me to configure a Final 
Cut system they were installing for a church in Uganda. I hadn't heard from him 
since he was getting ready to leave, so I sent him a note asking how the install 
went.

I was deeply touched by his reply and want to share it with you.

Matt writes:

Welp, where do I start?  Let's just say these 6 guys have the best 
editing system in all of Uganda and you had a lot to do with it.  I don’t 
know about you, but that sounds like a great “latest news” on your 
website. But seriously, the trip went really well.  I was a little 
surprised how quickly they picked everything up. They all seemed to 
grasp FCP and LiveType really well as well as Photoshop Elements and 
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DVD Studio Pro.  They email me all the time and continue to thank us 
for the system.

Most of the content they’re producing is for a TV station that reaches 
about 300,000 people all over Southern Uganda so their work is 
definitely being seen by people. 

Timothy, one of the guys I hit it off with, sent me a DVD of some of 
the work they’ve done since November but I haven’t had a chance to 
watch it yet. A group of people from Simi Valley were there in 
February and said they watched a few shows on TV that the guys had 
produced.

So.... All of that to say, it’s working beautifully.  So far, so good.  I’m 
hoping to go back out there in 06 and do some more training for 
shooting & basic editing techniques, build up more systems, etc.

As a side note: I think it’s important you understand what the system 
will be used for.  A lot of times, community leaders and some of the 
local pastors go out into the bush, villages that are literally in the 
middle of nowhere, and using portable DVD players, they can play 
training videos on how to bandage wounds, steps to follow in order to 
prevent malaria, how to build a hut, protecting themselves from rebels 
in the North, etc... Everything you can think of.  It’s pretty amazing.

So when you think about the system, remember that. It’s not just an 
editing system for some kids, it’s a tool for these people and this 
country, a tool they can use to reach hundreds of thousands of people 
and you helped put it together.  

This was a great and unique project for us.  I miss those guys and I 
miss them smiling all day while I was there, going through everything 
with them and just seeing them so blessed and truly grateful for what 
we were doing.  It was such a no-brainer and such a simple gesture 
for us, but for them it meant the world.

Thanks again for everything.

[ Go to top. ] 

Countdown to NAB

NAB is less than a month away (April 17) and I'm getting excited. 

Because of NAB, next month's issue will be out after NAB so I can include any 
NAB announcements that seem relevant to Final Cut users. (OK, perhaps not ALL 
the announcements, I can't write that much -- just those that strike me as 
interesting.)

In my opinion, last year set the stage. This year should be amazing -- I'm 
expecting major announcements from a variety of vendors. Like I said, I'll have 
more details after the show.

Just a reminder -- there is a new operating system and software coming in the 
next few months. I'm really looking forward to seeing what Tiger, among others, 
looks like. 

However, I'm only initially loading it on my test system. My main production 
editing system will stay firmly rooted in the past until I make sure I can upgrade 
smoothly and safely. Save yourself anguish. Don't upgrade the instant the new 



toys are announced. A little initial restraint can save hours of unnecessary 
downtime.

[ Go to top. ] 

Larry Releases Training DVD on DVD Studio Pro 3

If you want to work faster, and smarter, with DVD Studio Pro 3, I just recently 
completed a training DVD for Lynda.com filled with tips and techniques you can 
use immediately.

Learning Apple's DVD Studio Pro 3 is a QuickTime movie-based tutorial intended 
for the beginning or intermediate DVD Studio Pro user. The DVD includes over 6 
hours of tutorial movies and complete exercise files covering Compressor, A.Pack, 
DVD SP templates, creating menus, markers, stories, subtitles and scripts.

I am well into your [DVD Studio Pro 3] tutorial on Lynda.com. I have 
[watched] several tutorials on [Lynda's] fine system but have found yours to 
be easily the best so far. I use DVDSP3 as a producer of industrial and 
promo DVD work in Adelaide, Australia. BTW, I love the humor and your 
droplet ideas are great. Thanks! (J.B. 1/13/05)

This DVD is available now for $99, plus shipping and handling. Click here to buy it.

New Poll - HDV

We have a new poll posted that I'd like your opinion about -- HDV is a very hot 
buzz word right now. So, I'm interested in learning how soon do you expect to 
start editing HDV?

Click the link above to take the poll. You'll see the results right after you vote. 
Thanks!

Adam Wilt's comments on HDV

http://www.larryjordan.biz/cgi-bin/ecommerce/ac/agora.cgi?xm=on&product=DVDs


And speaking of HDV, after last month's discussion of working with the HDV 
format, I received the following comments from Mike Horton, chief cutter for the 
L.A. Final Cut Pro User Group, with further clarification from Adam Wilt, on using 
HDV.

Mike writes:

Great stuff, again, Larry!

FWIW and in response to the HDV via iMovie to FCP thang everyone is 
struggling with, we have all basically come to the conclusion it just 
doesn’t work. Below is Adam Wilt's reasoning which I [wanted to share 
with you.]

Adam Wilt writes:

This discussion started from an email, where the question was asked 
whether using iMovie as part of an HDV workflow in Final Cut is viable.

[In my opinion, ] I tried it and it's not viable for real work.

HDV 1080i clips captured in iMovie 5 using the Apple Intermediate 
Codec report themselves as being 1920x1080 in the Finder's Preview 
Pane and in FCP's clip properties, but if examined in QT Player Pro, 
Video Track Format is shown as 1440x1080 (which is not the native 
size of a 1080i HDV frame). 

Hmmm... Therein lies the rub.

I tried cutting in FCP using a sequence setting of 1920x1080 with the 
AIC, and it failed to render ("codec not found").

If instead I set the sequence to 1440x1080 (following some hints from 
Mike Curtis), I *can* render and even do lots of stuff in real-time--but 
AIC clips dropped into the timeline display in the leftmost 1440 pixels 
of the image, with the right edge of the clip (about 3 pixel's worth?) 
then repeated across the rest of the canvas--until I render, at which 
point the image fills the entire width properly. However the horizontal 
scaling is utter crap (technical term) with aliasing and moiré, and 
completely unusable. It appears as if every 3rd pixel is replicated with 
no other processing.

This may be what Frederic referred to as being "buggy". I refer to it as 
" nice tech demo, but not usable."

Within iMovie, it appears that multigenerational rendering (one does 
multigen testing to amplify defects one might not see in one 
generation) back to HVD via AIC is not as as good as Canopus Edius 3 
(HDV native or via Canopus HQ) but better than Vegas 5 / 
MainConcept (HDV native or via Cineform CFHD).

Apple's renderings are unity-gain; luma and chroma stay dead on to 
where they should be. MPEG defects are admirably minimized, 
although there is a visible softening of fine detail over five generations.

However, the killer is that each generation (including the first) shows 
what, were this Hi8, I would instantly tag as excessive digital dropout 
compensation: frequent bursts of repeated or downwardly displaced 
lines of data, so that the picture "twitches" as it plays (the "DOC 
bursts" run anywhere from around 16 pixels to a full screen's width). 
VERY odd indeed!

http://www.lafcpug.org/


It really does look like trashed Hi8 in an EVO-9850 with the DDOC 
turned up to 11. (Except of course this is high-def Hi8. Who says there 
ain't no progress?)

Rendered effects, like fades and cross-dissolves, show further, 
excessive degradation of all sorts. This may be an iMovie rendering 
issue (it appears as if all transitions are rendered at quarter-
resolution) but I can't say for certain; I'm not an iMovie expert.

Based on what I've seen in my simple tests, Apple may have workable 
intermediate and final MPEG codecs here, IF they can get rid of the 
DDOC defect and perhaps bias it slightly more towards holding onto 
high-frequency detail. But today, even within iMovie, we're not there 
yet.

LumièreHD and HDVxDV are still the way to go, IMNSHO.

Larry, again: In a follow-up email discussion, Adam sent the following comments:

There was a posting on FCP-L today about some FX1 filmout tests that 
seems to indicate that Final Cut Express HD may format its AIC 
captures differently from iMovie5: in the case quoted, iMovie 5 AIC 
clips imported into After Effects needed horizontal scaling whereas 
those from FCE did not. 

So the workflow discussed below MAY be somewhat more workable 
with FCE as the capture/playback tool instead of iMovie 5. As I don't 
have a copy of FCE I can neither confirm nor deny that.

Also, I also just received an email from Marcus Van Bavel at DVFilm. 
He's got a new version of Maker that, among other things, undoes the 
pseudo-1920 sizing from iMovie HDV AIC files, so they can be cut 
properly in a 1440x1080 sequence. I'll be looking into it this weekend, 
but you might want to hit him up for more details.

[ Go to top. ] 

HDV in Videography

Finally, to wrap this discussion of HDV, the March issue of Videography has an 
article I wrote on the current state of editing HDV for both PCs and Macs.

For more information, visit the Videography website: http://www.videography.com

Technique: Working with Firewire Hard Drives

This technique grew out of a message sent by Christopher Warren, who asked:

I don't know whether you have ever talked about using Firewire hard 
drives for MiniDV with Final Cut Pro:

●     Whether to partition or not
●     I have problems with them starting up from sleep mode 
●     How many drive can you daisy chain together
●     Should you group different sizes or brand names together or 

keep them separate
●     Whether to turn off journalling for a speed bump

http://www.videography.com/


●     Cooling issues
●     And any other issues that would effect performance

Larry replies: Based on my conversations with a variety of hard drive and RAID 
vendors, here are my suggestions.

A FireWire Preamble

First, Firewire is a perfectly fine technology to use for capturing DV video. 
However, there are some things you need to be aware of in order to maximize 
your success.

When you capture DV, you are simultaneously capturing both video and audio at 
the rate of 3.75 megabytes per second. An hour of DV material (audio and video) 
takes 13.5 gigabytes to store.

While 4 megabytes a second may not sound like much -- yes, I rounded the 
number up -- it's actually pretty demanding on a hard drive, because the drive 
needs to deliver 4 MB/s second after second, minute after minute. For this 
reason, you need to get a FireWire drive that meets the following three criteria:

1.  It needs to spin at 7,200 RPM, or faster
2.  It needs an 8 MB cache
3.  It needs an Oxford 911 chip for FireWire 400, or, 
4.  An Oxford 922 chip for FireWire 800.

If your drive meets those three criteria, it is reasonably likely to work well with 
Final Cut.

But wait, there's more.

In an ideal environment, FireWire 400 transfers data at 50 megabytes per 
second. However, while that's the maximum data transfer rate of Firewire 400, 
the hard drive inside the case is nowhere near that fast.

Generally, a single external FireWire hard disk moves data at between 20 and 25 
MB/second. SATA drives will be somewhat faster. Writing data, by the way, is 
always faster than reading. You can increase this transfer speed by using a RAID, 
but for this discussion we will limit our comments to single drives.

Every stream of video on your timeline requires roughly 4 MB of data each 
second. So, doing a dissolve means that during the dissolve, the hard drive needs 
to send 4 MB/s for the outgoing shot and 4 MB/s for the incoming shot. If you 
have three images on screen at once, that's 4 MB/s times three.

Complicating this process is that FireWire is a very “chatty” protocol; the drives 
spend a lot of time talking to each other, and the computer, reminding each other 
they are still connected and making sure everything is functioning OK.

For this reason, I allow 25% of total data throughput for the computer and drives 
to exchange FireWire protocol information, separate from any audio or video 
material.

On G-4's, I reserve less, on G-5's I reserve more.

Wrapping up this preamble before answering your questions is that the fuller a 
hard disk gets, the slower it plays. And, in fact, you can so fill up a hard drive 
that it neither reads, nor writes, data.

While Phil Hodgetts and I have agreed to disagree on how full, exactly, is too full, 
I recommend you keep your hard disks no more than 90% full. The world will not 



end if they get fuller, but they will start to slow down.

Getting Down to the Questions

So, with that as an introduction, here are my answers to your questions:

1) Should you partition a drive? No. In the past, partitioning was 
necessary in order for applications to work properly. With today's 
operating systems and applications, there is no performance 
advantage to partitioning. As the engineers at Huge Systems told me, 
partitioning is neither good nor bad. In the future, though, partitioning 
will decrease system performance.

The only time I recommend partitioning is when you want to create a backup to 
your boot disk. However, never store media on one side of a partitioned drive 
with the operating system and applications on the other. That is a recipe for 
dropped frames.

2) Sleep mode, by definition, tells your hard drives not to spin. If they 
are not spinning, they are not sending or receiving data from your 
system. In other words, sleep is bad. Go to System Preferences > 
Energy Saver and set sleep to “Never,” and UNcheck the two check 
boxes. Unlike people, your hard drives will not die for lack of sleep.

3) How many FireWire drives should you daisy chain together? The 
FireWire spec says 63. Sigh... I don't recommend that number. I have 
a few clients with 6-12 FireWire drives talking to a G-4. However, G-5s 
seem to have a problem when they talk to more than 4 FireWire 
drives. In my opinion, if you need that much storage, you are much 
better off with a RAID than a collection of FireWire drives. I would not 
recommend more than a dozen or so drives to be attached to any 
system.

On the G-5 in my studio, I have two internal drives and three external FireWire 
drives and they all seem happy.

4) Should you group drives by size or brand? First, there's no way to 
"group" drives. FireWire is just a bus -- all the devices "see" and "talk" 
to everyone else. There is no sectioning, or grouping. Keep in mind 
that you want to keep your FireWire cables as short as possible. When 
the total length of FireWire cable between all drives exceeds 15 feet, 
data errors can start to result. If you need to move drives a long way 
from the computer, be sure to use amplified FireWire cables.

Second, a FireWire device has no preference for a specific size or brand. So you 
won't need to worry about that.

5) You should turn journaling ON for your boot disk, the one with the 
operating system on it. You should turn journaling OFF for any hard 
disks that you plan to use for capturing media. If you don't know how 
to turn journaling on or off, here's an article that explains it.

http://www.larryjordan.biz/articles/lj_journaling.html

6) Cooling issues. As long as there is air flow around the drive, you 
won't need to worry about cooling. If you are putting all your drives in 
a box to keep the noise down, you'll need to make sure the box stays 
cool. (Smoke curling up from the back of your drive is simply nature's 
way of telling you that your data is now toast...)

However, if the temperature in the room is comfortable enough for 

http://www.larryjordan.biz/articles/lj_journaling.html


you to work in your shirt sleeves, your drives will do just fine.

Hope these answers help.

[ Go to top. ] 

Client Report: RAID problems and OS upgrades

I had an interesting conversation this morning with ATTO tech support (www.
attotech.com) regarding problems a variety of clients, all of whom are using 
RAIDs, are experiencing.

Their basic problem is that the RAID no longer works properly -- icons disappear 
from the desktop, data rates drop, more drop frame errors -- after an operating 
system upgrade.

What I learned is that back in OS 10.3.5, Apple changed the way it communicates 
with SCSI devices in order to properly support multi-pathing. This is a technology 
that allows the operating system to more reliably recognize and communicate 
with the different hardware controllers in a SCSI device.

The problem is that many RAID manufacturers needed to update their firmware in 
order to support this change.

Normally, this would not be a big deal. These sorts of modifications occur all the 
time. So, I'd recommend the client drop back to an OS version that works; such 
as OS 10.3.4. What makes this tricky is that OS 10.3.5 is the minimum OS 
required to use Motion. So, many clients unsuspectingly update their OS so they 
can work with the Motion demo, only to have their entire edit system stop 
working.

If you are experiencing problems AND you are using a RAID, I suggest you 
contact your RAID vendor about an upgrade. If you are only using FireWire 
drives, this problem does not apply to you.

[ Go to top. ] 

Tip: What Do All the Different Outputs on a Tape Deck Mean?

While we are on the subject of hardware, another reader, I must confess I lost his 
name, asked me if there was a difference between all the different outputs on his 
tape deck.

Which set me to thinking. I've worked with decks for so long that I just take their 
various outputs for granted. So, if you're new to this whole tape deck thing, 
here's a quick primer.

Video Connectors

Let's start with the connectors. There are four principal types of video connectors:

http://www.attotech.com/
http://www.attotech.com/


Jerrold, or F-connector

RCA

S-video

BNC

The F-connector screws, or slides, onto a post on the back of your deck or TV 
set. This connector is used for connecting RF (radio frequency) signals. While very 
useful in connecting a VCR to a TV set, it has very, very limited use in 
professional (or even semi-professional) video. It's principally used for RF signals.

The RCA connector is the one that's used on most consumer gear. Normally 
used for audio signals, it can also be used for video when inexpensive connectors 
are required.

The S-video connector, unlike the other three, has four wires to cary video 
signals. (The others all use two.)

The BNC connector is a twist-lock silver plug used in most professional 
installations. The twist-lock means it won't come off by accident. Due to the way 
it is constructed, and the quality of the wire attached to it, BNC connectors 
provide higher quality than RCA connectors. Given the option, I always prefer 
gear that uses BNC connectors for video.



Video Outputs

Now, back to our discussion of outputs. Depending upon format, and how much 
you spend, a tape deck can have up to five input/output options. Here's a quick 
description of each, from lowest quality to highest (and cheapest to most 
expensive):

●     Composite. This uses a single connector, either RCA or BNC, 
that is the lowest common denominator for all video sources. It 
is the traditional connection on VHS decks. It provides an 
acceptable level of quality, but nothing you'd write home about.

●     S-Video. This uses a higher quality signal, with greater 
resolution and less color "fuzziness." This is an excellent option 
for connecting decks for dubbing.

●     Component. This uses a three wire connector, where each wire 
carries part of the color components of a signal; as well, the 
green wire also carries the black-and-white signal information. 
This is the best choice to provide the highest quality for analog 
signals. It is the preferred connection for Betacam SP and other 
analog tape formats. As well, it is commonly used for DVD 
output to a monitor.

●     Firewire. This is a 4-wire digital signal (the other two 
connectors on a six-wire FireWire connector carry power to the 
external device). As FireWire is digital, the quality of the image 
is determined by the source format, rather than the 
transmission. Generally, FireWire provides the highest quality for 
DV signals.

●     SDI (Serial Digital Interface). This uses a single wire BNC 
connector to carry digital signals. This is the standard digital 
interface in a broadcast/high-end post production environment 
because of its ability to travel longer distances than FireWire. It 
is the preferred connection for DigiBetacam decks.

While there are a few technical benefits to capturing DV-recorded output using an 
SDI connection on a very high-end deck -- specifically for converting color 
sampling, or integrating Betacam and DV footage -- in general, a FireWire 
connection is the best method for transferring DV footage into your computer.

[ Go to top. ] 

Graeme Nattress: Color Sampling

One of our on-going discussions is the issue of color sampling; which we describe 
using terms like 4:1:1, 4:2:2, 4:4:4 and, with DVD and HDV, 4:2:0.

And, I thought I pretty well understood what these meant. I should have known 
better, because someone who DOES know better wrote a nice article illustrating 
the difference.

Allow me to present Graeme Nattress (http://www.nattress.com) with a short and 
highly lucid description of what all the numbers mean. (For those of you who 
worry about such things, "colour" is the Canadian spelling...)

Color Terminology

Component digital video is often referred to as YUV, but this is not an accurate 
description of component digital video, but instead refers to a set of intermediate 
qualities used in the formation of analogue composite video. The correct 
terminology for the components of digital video is Y' Cb Cr. 

http://www.nattress.com/


The Y' represents luma, the ' is important, reminding us that it is non-linear 
(gamma corrected). The Cb and Cr are chroma components that are often 
wrongly referred to as U and V. The Cb is calculated as B' - Y', and Cr is R' - Y'. If 
you are interested in more details, check out Charles Poynton's excellent articles 
at http://www.poynton.com.

Chroma Sampling

The CCDs that capture our image inside our video camera, capture colour by the 
use of Red, Green, and Blue filters. The phosphors in our CRT monitor, and filters 
in our LCD monitor and DLP projector also use Red, Green and Blue filters. 

Why is it then, that digital video is stored and manipulated as separate luma and 
chroma components? Separate luma and chroma are used so that the resolution 
of the chroma can be reduced with respect to the resolution of the luma so that 
large savings can be made in the amount of data that needs to be transmitted -- 
it is a form of compression. This reduction in the resolution of the chroma 
components works perceptually as our human vision systems are not as able to 
see fine details in colour as we are in lightness.

There are a number of methods of chroma sampling, and they each have 
terminology that refers to the chroma resolution (the second and third numbers) 
as compared to the luma resolution (first number).

4:4:4

Full resolution luma is represented by the number 4, and as the chroma 
components Cb and Cr are also 4, there is no reduction in resolution. 4:4:4 
sampling is mostly used for RGB images, although it can be used for Y'CbCr, 
although no camera records 4:4:4 Y'CbCr.

http://www.poynton.com/


4:2:2

Full resolution luma, and half (2/4 = 0.5) resolution horizontally on the chroma 
components. This is the traditional broadcast standard for chroma sampling and is 
used by DigiBeta, DVCpro50 etc.

4:1:1

Full resolution luma and quarter (1/4 = 0.25) resolution chroma components. This 
is the system used by NTSC DV and PAL DVCPro.



 

4:2:0

Full resolution luma, and half resolution in the horizontal direction and vertical 
direction for the chroma components. 4:2:0 is a very complex chroma sampling 
with many variants depending on whether the video is progressive or interlaced, 
or if it is being used by PAL DV or MPEG2. 

4:2:0 compresses the resolution of the colour to 1/4, just like 4:1:1 compresses 
the resolution of the colour, but whereas the compression in 4:1:1 is horizontal 
only, the compression in 4:2:0 is horizontal and vertical. 

This picture, above, illustrates PAL DV 4:2:0 chroma sampling. 

[ Go to top. ] 

Hand's on Training for Final Cut Pro gets rave reviews.

Thank you to everyone who has written in about my book. I'm grateful for your 
support. If you haven't ordered your copy yet, now's the time. Here are two quick 
reviews to twist your arm.

Larry, I'm a self-taught FCP devotee with a considerable investment in 
various after market Final Cut Pro books but yours is the best I've ever read. 
Though I'm familiar with much of the material you've presented, you 
revealed many valuable tips and "secrets" and, more importantly, clarified a 
number of points with real-world examples and logic. (D.S. 3/14/05)

I am faithfully studying your book and DVD every day. I am now going into 
chapter 5. It is absolutely THE book for me. Everything you teach is exactly 
what I need to know, and phrased so well, I can actually understand it! I 
don't know what I'd do without it! (J.G. 3/8/05)

You can buy the book at Amazon.com, at most major bookstores, or from me. 
And, if you buy from me, you can also order your own personal inscription - 
FREE! Click here to order a copy.

Thanks!

Article: Exporting A Final Cut Pro Sequence into LiveType

http://www.larryjordan.biz/cgi-bin/ecommerce/ac/agora.cgi?xm=on&product=Books


Michael Murray wrote in with a question about how to export a Final Cut 
sequence for use in LiveType; which led me to think about one of the truly time-
saving features of FCP HD -- round-tripping.

Allow me to explain.

Exporting a Sequence from FCP for LiveType

 

1.  Since you only need to work on a small section of your sequence 
for titles, set an In and Out so only the portion of your sequence 
that you need to work on in LiveType gets exported.

2.  Select File -> Export -> For Livetype

 
3.  If you are exporting LiveType files as part of your sequence, as I 

am here, select which you need exported. In this case, these are 
LiveType textures which I want to see as I am adding text, so I 
am exporting all of them.

 



4.  Select where you want to store the movie. Don't check "Make 
Movie Self-Contained." As this is only a temporary file, you'll 
trash it after the LiveType work is done; so there's no need to 
waste time and space making it self-contained.

5.  Open LiveType and import your movie using File -> Place 
background movie. Notice that only that part of your sequence 
between the In and the Out is imported.

6.  Don't worry about the video quality of your imported media. This 
is only for reference, so it's quality isn't important. Also, notice 
that the video appears BELOW the heavy gray line in the 
timeline. This means it has been placed as a background 
element.

7.  Create your text animation keeping all elements ABOVE the 
heavy gray line. When you are finished, save your LiveType 
project file.



8.  Before moving it back to Final Cut, you need to set a LiveType 
preference. So, go to Edit -> Project Properties and make 
sure "Render Background" is NOT checked. This will exclude your 
imported footage from the LiveType project you are about to 
bring into Final Cut.

9.  Save your LiveType project. You do not need to render the 
movie -- just save the project file.

10.  Switch back to Final Cut and import the LiveType project (File -
> Import -> Files). It will appear in your Browser.

11.  Edit it into your Timeline the same as you would edit any clip. All 
the transparency information you created in LiveType has been 
retained, so it will easily key over your sequence.

12.  Now, let's say you realize you have a typo in your text. Here's 
where the magic starts. Control-click on the LiveType clip in your 
Timeline and select "Open in Editor."

13.  Final Cut will automatically open LiveType and load that project 
file so you can make changes.

14.  When you are done making changes, simply SAVE your file and 
switch back to Final Cut. Your newly altered and saved file is 
automatically updated into Final Cut!

This ability to quickly switch between Final Cut and another application to update 
a file is called "round-tripping" and it has saved me hours of production time. You 
can round-trip between Final Cut Pro HD (and only the HD version) and LiveType, 
Motion, and your favorite still image, video and audio editing programs.

You set which applications Final Cut should use for round-tripping in Final Cut Pro 
HD -> System Settings -> External editors tab. This illustrates how I have 
my system configured.



This is a great technique and well worth the few minutes it takes to learn in hours 
of time saved.

[ Go to top. ] 

Reader Mail

This is my favorite part -- reading and answering your comments. We've got a 
great collection this month, so let's get started.

Color Sampling

Graeme Nattress writes:

In reading your article on when and why to select the DV format for 
your project, I'm getting confused.

As part of the article, Phil Hodgetts commented:

"To clarify: the numbers 4:4:4 are the ratio of [the] sample of the YUV 
color channels within the datastream. Graeme is correct that there is 
no tape format that records 4 U and 4 V samples for every Y sample 
recorded.

"What I [Philip] think you [Larry] meant to convey in that last 
sentence is that "...DV contains half the color resolution of professional 
standard definition formats". DV has only 1/4 the color resolution of 
the luminance resolution of any SD format. In 4:2:2 Y = 720 x 480 (or 
486); U & V are 360 x 240 each; in 4:1:1 Y is still 720 x 480 but U & 
V are only 180 x 120 each but offset so that they "fill in" a bit for each 
other.

"Not a big thing, and the general principle is right, it's just me being 
picky."

Graeme continues:

In 4:2:2 Philip is saying that the Y is 720x480 and that the Cb and Cr 
are 360 x 40. (It's not YUV, it's Y'CbCr and we should all really start 
calling it what it really is, not YUV which, although easier to say, is 
actually nonsense. I know I've said YUV in the past, but I've learned 
that I was wrong) They're not, they're 360x480. It's only horizontal 
resolution that gets squashed. In 4:1:1, the luma (not luminance - 
luminance is not the same as luma) is still 720x480, but the chroma 
components Cb and Cr are 180x480 not 180x120!!! They are also not 
offset in any way.

I think Philip is getting confused with PAL DV, which is 4:2:0 where 
the luma is 720x576 and the chroma components Cb and Cr are 
360x288 and they are offset.

[I'm sending you an article that ] I'm working on about this very 
subject, which you're welcome to read. I'm still not finished the article, 
but it should explain things better than I can in an email as it has 
some funky pictures I made up.

One of the key points is that Beta SP is quite an ugly duckling 
compared to Digital Betacam, in that both it's chroma and luma are 
reduced in resolution from Digital Betacam, and that although DV is 
4:1:1, Beta SP would rate about 3:1.5:1.5 on the same scale, so it's a 

http://www.larryjordan.biz/articles/lj_choosing_dv.html
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real toss-up over which is better or worse. Given that luma is mostly 
made up of green, and that chroma-keyers work in RGB not Y'CbCr 
space, a properly smoothed DV chroma should be no better or worse 
than a Beta SP chroma to key with. The issue is that converting Beta 
SP to DV to get it into your computer is combining the worst of two 
worlds - DV artifacts + Beta SP artifacts, and you end up with 3:1:1 
on your resolution, which is atrocious!

http://www.poynton.com gives a lot of good info on luma vs. 
luminance and YUV vs. Y'CbCr.

Hope that helps.

Larry replies: Yes, that helps a lot; though I will confess I had to read it through a 
few times to understand it. I've presented your article in abbreviated form earlier 
in this newsletter.

You can go back and read it here.

[ Go to top. ] 

NTSC Setup

OK, time to get another discussion going. Feel free to warm up your flame-
throwers....

First, though, a definition. Traditionally, the black level of a video signal is called 
"setup." In NTSC video, but not PAL, nor NTSC-Japan, the setup level is set to 7.5 
IRE units (7.5% on FCP scopes and 16 when measured on an 8-bit digital scale).

DV video, on the other hand, sets black at 0 IRE / 0% / 0 digital units. This is a 
darker black than broadcast allows, so, it needs to be raised, using a device called 
a processing amplifier (proc amp). This proc amp is generally built into the 
capture card, or video deck or broadcast operation, so it's generally not an issue.

Except...

Mark Spencer writes:

Man, you really put in some time on these articles! Very thorough. 
Nice job.

One thing that has been bugging me for a long time that I think your 
newsletter could shed some light on - setup. It seems that most decks 
don't add setup out to your NTSC monitor so you aren't getting an 
accurate view of your black levels. This happens in the typical dv 
setup with FCP through firewire to a deck, and then out to the 
monitor. The solution is to install a TBC in-between the deck and 
monitor to add the setup, but I'm wondering if there is any other less 
expensive solution? I'm convinced that just about every DV-only editor 
has this issue.

By the way, here's a great article (or rather, series of articles) 
describing the issue:

http://www.signvideo.com/dv-black-levels-dvd-authoring-mpeg-2-
part-1.htm

I'd love to know your thoughts.

http://www.poynton.com/
http://www.signvideo.com/dv-black-levels-dvd-authoring-mpeg-2-part-1.htm
http://www.signvideo.com/dv-black-levels-dvd-authoring-mpeg-2-part-1.htm


Larry replies: I haven't read the entire link, yet, but the short answer is that 
setup is NOT an issue for DV. All DV decks put video at 0 IRE, which is where it 
belongs.

Mark: Ah, but when your program goes to broadcast, setup is added in 
the D/A conversion (either in the dub to an analog deck, or in the D/A 
converter in a DVD player), so when it airs, the black level is HIGHER 
than when you monitored it on your NTSC monitor - don't you think 
that is an issue?

Larry: No, because setup is also added on output from your DV deck to the 
monitor so you are seeing it correctly.

Mark: Actually, it's not, that's my whole point! Most DV decks do not 
add setup to the monitor, that is my understanding, and the article I 
referenced reinforces this. 

Larry replies: It seems we have two issues: first, do we need to add setup (i.e. 
increase the black level) when dubbing to tape, and the second is do we need to 
add setup when monitoring our DV signals. My understanding in talking with 
video engineers is that we do not need to change the black level when recording 
to tape. If a MiniDV tape is dubbed to Betacam or prepped for broadcast, the 
black level will be changed at that time.

However, much more intriguing is the issue of whether we should monitor our DV 
signals through a proc amp so that we are seeing it with setup at 7.5 IRE, rather 
than 0. (Again, PAL and NTSC-J editors don't need to worry about this.)

That is an excellent question that I am less sure about. Anyone care to chime in? 
I'd love to learn the answer.

[ Go to top. ] 

Live Cut Comments

Ben Balser:

Just wanted to drop you a note. I just finished a few more articles for 
a magazine, Flip4Mac review, Studio 1 DV Jib Arm review. But what I 
am really excited about is Live Cut. I hope you'll check this out and 
share it with your readers.

There are currently two products for FCP that will do multi-cam edits 
for you. One does up to 3 cameras at a time and costs $295 (www.
digital-heaven.co.uk) called Multicam Lite. Very nice software with lots 
of functions.

http://www.digital-heaven.co.uk/
http://www.digital-heaven.co.uk/


But the other option is my favorite. I'm so totally in love with this little 
gem. Not to mention it does up to 4 cameras at a time and is FREE. 
Yes, I said free. It's called Live Cut. I highly recommend any FCP 
editor who has to do multi-camera edits such as weddings and events 
get this. And I also strongly recommend they print out the page on the 
site that has the user instructions. Read the WHOLE page! There's a 
few features that aren't immediately obvious. Live Cut can be found at:

http://livecut.sourceforge.net 

This little gem has literally cut my wedding ceremony editing time in 
half (the part of the edit I hate doing). I can not tell you how much I 
love this application.

Keep up the great newsletter. I look forward to each one.

Larry replies: My opinions were drawn from a comparison Phil Hodgetts did 
recently at the LA Final Cut Pro User Group. I listened to his reasoning and agreed 
that Multicam Light sounded like the better program.

On the other hand, it is hard to argue with free. So, if you need to edit multiple 
cameras, now you've got a testimonial and a choice.

PhotoShop and Final Cut

This comment is from last month's issue where opening Mac-based PhotoShop 
files retains the layer information, while opening PC-based PhotoShop files does 
not.

Nick Toth:

I read with interest Jim Tapley's observations on Photoshop PC files in 
your latest newsletter and have some info to add.

I was recently working with someone who had made some Photoshop 
files on a PC. It's true that they import into FCPHD as a flattened file. 
However, if you right-click (control-click) on the file and choose open 
in editor (with Photoshop chosen as your still image files editor in FCP 

http://livecut.sourceforge.net/


setup), you will be greeted by Photoshop opening the file as a layered 
file with all of the layers intact!

I could not replicate this in any way on the Mac. If I re-saved the PC-
created file under another name on the Mac, the new file would revert 
to normal operation i.e.: importing as a sequence. Only the file 
originally created on a PC exhibited this behavior.

It gets more interesting. If you add layer effects (drop shadow, 
emboss, etc.) and re-save, FCP will recognize the layer effects without 
any of the merge into layers nonsense we typically go through!

There is some really cool potential there that I haven't had time to 
investigate further. FCP appears to like something the PC is doing with 
Photoshop files.

Thanks for all the great info!

It still seems to me if there's a way to get FCP to recognize Photoshop 
layer effects, it would help streamline the production process by 
eliminating the "merge to an empty layer" step. In many cases this 
need to merge layers can eat up a significant amount of time and is 
only a work-around for how it 'should' work (in my opinion.)

Michael Lynch adds:

I can vouch for the fact that Photoshop files created on the PC will not 
open in FCP (they open, but are one layer). This drove me nuts for a 
month before I finally installed Photoshop on my MAC and tried it from 
there. I posted to Creative Cow, etc... but nobody caught the 
connection (then again I don't think I specified PC vs. MAC). Note: you 
can create a document on the PC, but it must be opened and saved on 
the MAC version for FCP to open it correctly, even if you've made no 
changes to the file!

Your newsletter is great - keep up the good work!

Continuing the discussion, Ann Farrell chimes in:

Photoshop CS has, in addition to a way to set the pixel aspect ratio for 
display in an image, a number of new presets that address digital 
video considerations. In PS CS, if you go to File -> New and then look 
at the presets pop-up there is a list of preset image sizes customized 
for digital video. These include the proper pixel aspect ratio setting. 
This is what moved me to upgrade!

Nick Newman adds:

I read this article and here is my solution. I have both PC & Mac and 
utilize Photoshop 7 on both systems. I have never encountered a 
transfer problem of either a flattened JPEG or a a layered file (other 
than font exchanges). I use a USB memory card (256 MB) to transfer 
the files. On occasion I will also burn to a disc if more space is 
required. 

[So, when I'm ready I ]import to Photoshop – manipulate – save to 
my Glyph 120 and import to FCP 4.1.1 One problem I did encounter 3 
years back was that I need to make sure I keep the DPI low (but 
quality at high – 12) and make sure that I keep the save and usable 
file on RGB not CMYK. After that – no worries.  PS works great for 
using those same files in After effects as well.



Hope this helps someone.

Larry replies: Several key points here:

1.  Avoid using JPEG images for video, TIFF is much better
2.  As video is a fixed resolution, I've found it best to do all my 

video graphics at 72 dpi.
3.  Never bring CMYK images into Final Cut, they won't work
4.  FCP 4.5 handles graphics differently from 4.1.1. As usual, test 

your graphics to make sure everything works as you expect 
before spending hours creating files that don't import properly.

5.  Remember that single-layer graphics need to be created at 720 x 
540 x 72 in PhotoShop in order to look geometrically correct in 
Final Cut.
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Backups and Upgrades

This comment came from last month's article about how handle working with two 
different operating system - one for testing and the other for general production.

Jan Biddal:

A solution to that particular problem could be buying two cheap 
external firewire hard-drives. [Use] Carbon Copy Cloner [to copy] a 
perfectly working operating system to this hard-drive and check if 
everything works then boot from the [second] hard-drive.

I can see two advantages with this setup

1) When Apple releases another update you have the opportunity to 
test the update on the firewire hard-disk and see if it breaks anything. 
When everything runs as it should with the new operating system 
upgrade the internal hard-drive and the other firewire hard-drive.

2) If your main hard-drive crashes you will be able to carbon copy 
clone your system back to a new hard-drive from the firewire hard-
drive.

You can find the software here: 
http://www.bombich.com/software/ccc.html 

If people like it (it saved from a lot of time and inconvenience when I 
had to upgrade the hard-drive in my powerbook), they might consider 
making a small donation to Mike Bombich. 

Larry replies: You could consider even making a large donation...

I use Carbon Copy Cloner, and a similar hard disk setup, on my system. It seems 
to work fine -- better than other utilities I've tested (and I've tested a lot). On the 
other hand, I haven't had a crash since I started using it, so I can't attest to how 
well it restores systems after the crash. On the third hand, I will be completely 
happy if I don't have a crash to test this on.

Calling All Track Gaps

http://www.bombich.com/software/ccc.html


Damion B. writes:

My question: Am I wrong in thinking it would be pretty easy to have a 
single command that closed ALL track gaps? Have I just not found it 
yet?

Larry replies: “Easy” is such a slippery word. First, though, you are correct, there 
is no way currently in Final Cut, to automatically close all track gaps.

And, I would argue, this would probably not be a good idea. There are too many 
issues of how to handle sync to worry about. Closing a track gap (a gap in the 
video where there is no corresponding gap in the audio) means the video changes 
position, but not the audio, How would the software know how to handle music 
cues spotted into lower audio tracks? Or, adjust text titles on V2, when there's a 
gap on V1.

This strikes me as much easier to say than to write -- or, much worse, force us to 
use the Auto-Select buttons far more.

Sigh. I don't like track gaps, but I like automated tools that close all gaps much 
less.

[ Go to top. ] 

Connecting a Monitor to a PowerBook

This refers to an article describing how to connect a video monitor to your 
computer without using a capture card.

Brian Seegmiller writes:

Larry, in your last newsletter their was an email asking about 
previewing video like a client would see on a TV. I have discovered 
something not covered in your answer. I connected my PowerBook to 
a monitor from the S-video out on the laptop. 

At first you will see an extension of your desktop. Open up FCP and 
select view/video playback and you will have options like digital 
cinema preview main or something like that. 

Anyway, selecting one of these will give you a preview of the program. 
And like you mentioned before selecting "best for video" and 
"overscan" in the monitor system preferences will make it look better. 

Larry I did not know if you covered this trick.

Larry replies: Brian, thanks for pointing this out. Actually, connecting a video 
monitor to a PowerBook is as easy as Brian indicates, because the S-video port is 
built right in.

Capturing 24P from a DVX-100

This is a follow-up to the Noah Kadner's article on capturing from a DVX-100.

Joe Chipmin writes:

Per your referenced article, does the capturing of 24P Advanced 

http://www.larryjordan.biz/articles/lj_monitor.html
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footage at 29.97 also apply for 24P footage? If not, what is the "best" 
capture rate or setting should one use?

Noah Kadner:

For 24p standard you still capture at 29.97. Then if you wish to 
conform the captured footage to true 24p you do this in CinemaTools 
according to the manual. That's why 24pA was designed, because it 
can be conformed automatically by FCP. 24p standard requires more 
work.

Joe: 

OK, then, a follow-up question. Using the Panasonic DVX100 in 
24p/24pA, am I able to keep the 24p look (or even some aspect of it) 
when I output it through FCPHD to regular VHS and NTSC DVD 
formats? Are there any applications for shooting in 24p and outputting 
it in the NTSC world? I would need to interlace it for NTSC, correct?

When a "film" is set up for NTSC broadcast or DVD, its 24 fps is 
"converted" to be shown in the NTSC format, yet it retains most of its 
original 23 fps look.

Larry replies: Final Cut automatically adds pull-down frames in real-time for any 
24 fps footage it is editing. So, if you have a 24 fps timeline, Final Cut will add all 
necessary frames so your video can be displayed on a standard video monitor. 
And interlacing is also added automatically, regardless of frame rate.

[ Go to top. ] 

Final Cut, ProTools and OMFs

Thom Monahan writes:

Thanks for posting the article on exporting audio out of Final Cut into 
OMF for use in ProTools.

I use Pro Tools LE all the time to mix projects that have been 
delivered to me as OMF exports from FCP. What are the advantages of 
using DV Toolkit?

I just use the freeware "OMF Tool 2.08" that Digi has on their site. I've 
been using it forever, it runs well in Classic in OSX. Sometimes it can 
be a little strange, but I've never run into any major problems. The 
one thing to make sure is that cross-fades are not included in the FCP 
OMF export.

Since FCP doesn't export volume change information, why spend 
$1000 on DV Toolkit if the majority of your work comes from FCP? It 
seems like you might just as well skip it.

Larry: I use ProTools almost exclusively for mixing video, not music, tracks.

The big problem with using the OMF Tool is that it only runs in OS 9. I am not 
comfortable switching between Classic and OS X -- for that reason, I didn't 
mention OMF Tool 2.08. Further, as it is not supported by either Apple or 
DigiDesign, I didn't want to steer new users in that direction.

The disadvantage to the DV Toolkit is the price -- $1,000. The advantage is that it 
is OS X native and fully supported by DigiDesign. And, of the four software 
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packages in the bundle, I use three of them a lot:

●     OMF Import (called DigiTranslator)
●     DINR -- a KILLER noise reduction program
●     The ability to spot audio to the timeline using timecode, as 

opposed to minutes and seconds
●     As I don't do ADR work, the ADR program didn't interest me.

For these reasons, I felt it was a good value for the money.

Thom replies:

I know what you mean about switching between OSX and OS9. In my 
normal work flow, I use three macs, a laptop that's OSX, another 
that's dual boot, and a tower that's OS9. I encounter some oddness 
now and then, swapping firewire drives around, but it's a necessary 
evil.

The only time that Classic is ever opened on the powerbook that's 
running OSX, is when I have to use OMF Tool. There are definitely a 
few buggy things about it but I have a protocol that I follow strictly.

1.  Start Classic
2.  Launch OMF Tool
3.  Use the drop down menus too navigate to a file to open with 

OMF Tool.
4.  Convert the file to a ProTools session
5.  The Important One: QUIT.

This seems to be the real stickler. OMF Tool in my experience will only 
process one file correctly each time that it is launched. You must quit 
and relaunch it again if you have another file to process. You don't 
have to restart Classic, but you do have to quit, relaunch, process, 
quit, relaunch process, etc...

I have much better results with OMF Tool this way.

Also: I have had no luck at all trying to convert cross-fades from FCP 
sessions with OMF Tool. I always have to ask the editors to make sure 
to uncheck the "include cross-fade" option. What I've found, if the 
cross-fades are included in the OMF and OMF Tool is used to convert 
to a PT session, there is a cumulative drift that is unique to each track 
in the session. It seems like each cross-fade is included as extra time 
in each track, pushing tracks out of sync. I'm not sure if this is the 
case, but that's how an editor and I diagnosed the sync issues that we 
were having.

In a OMF export that included cross-fades we found that the tracks 
with no cross-fades remained in sync, but the more cross-fades that 
were present in a track, the greater the drift.

Since then, no exports with cross-fades.

I've been doing this since before OSX and since the bulk of my work is 
music and composition based, I never wanted to pony up 1K for DV 
Toolkit.

For me, I've had better results with the Waves denoiser than with 
DINR. Just my opinion, haven't used a version of it since I started 
using Waves.



Judy Korin adds:

Thanks for your helpful article about exporting Final Cut Pro OMFs for 
use in ProTools sessions.

One little detail that we've discovered that you might want to add:

Your FCP sequence name, project name and OMF file name need to be 
short (i.e., under 10 characters and with no funky characters) or else 
ProTools will not be able to open/read the file!

Just one of those little things that can really trip you up...

Larry replies: Judy, and Thom, thanks for your comments!

Here's the commercial that supports this newsletter.

I provide system design, consulting, editing, training and support for Final 
Cut Pro, DVD Studio Pro and Motion.

You can review my support and training services here.

If you need training, help or advice with Final Cut Pro, DVD Studio Pro, or 
Motion, I'd appreciate it if you would give me a call, (818) 879-5105, or 
send me an email -- larry@larryjordan.biz -- worldwide.

My client list speaks for itself.

Your support of my services keeps this newsletter free.

Thanks.

Oh, and please buy my book - and DVD! Thanks.

Wrap-up

Remember, next month's issue won't be out until after NAB, so please be patient. 
And take a minute to vote in the poll -- I enjoy learning more about your interests.

Well, that's it for this edition of the newsletter. Let me know what you think, and 
tell your friends to subscribe. I love reading your comments and sharing them 
with others. 

Or, send in some ideas of what you'd like us to talk about.

Even better, send in some tips of your own. I'm happy to publish everyone's 
ideas. That way, we all learn!

Thanks -- and have fun editing!

Larry

[ Go to top. ]
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sign up at www.larryjordan.biz.

To unsubscribe, simply send me an email and I'll drop you from the list. This list is not 
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However, due to the variety of possible system and software configurations, the author 
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The opinions expressed in these newsletters are solely those of the author. This 
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trademarks are the property of their respective owners and are mentioned here for 
editorial purposes only.
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